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What’s in your toolbox?

Editors’ notes
As the next generation of interns in the great circle of Unregulated Contaminant Monitoring Regulation (UCMR) life, Jillian and I are continuing
the tradition of entertaining and informative Updates. We are following in
the innovative footsteps of our predecessor, Brenda
Parris, who is working with new tools on the UCMR
team.
While moving into our cubicles, we have had more
than a few instances of poking ourselves with pins and
dropping heavy objects on our toes. We spent a lot of
time searching for the perfect hammer or screwdriver
for all those projects we have come across.

Have questions about
UCMR2? Learn
about your toolbox!

Luckily, the answers to all of your UCMR2 questions
can be found in your toolbox. In this edition of The UCMR Update, we
gathered the most important resources available for UCMR2. Find out
more about the tools in your toolbox and where to find them in this
issue!

Reminders to nail to the wall
Reporting monitoring results
Entity

Action

EPA Approved Laboratories

Must post monitoring results to SDWARS within
120 days from sample collection

Must review and approve data using SDWARS
Large Public Water Systems
within 60 days of the Laboratory posting your
(serving over 10,000)
results
Paper reports are sent from EPA directly to
Small Public Water Systems small PWSs and States. No action is required
by the small PWS.
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General UCMR Information
Drilling to the core of UCMR2
Now that UCMR2 implementation is
in full swing, the tools needed for
compliance are more important than
ever. This issue of The Update outlines the resources available and
where they are located. Some basic
tools are listed here:
•

SDWARS: The Safe Drinking Water Accession
and Review System (SDWARS) provides valuable functions for large PWSs, Labs, States,
and Regions. SDWARS is an indispensible tool
that is a great place to start nailing down answers to important questions! See pages 4-6 for
more details.

•

•

The UCMR2 Web site: The Web site is
the best resource for those who have
questions about any aspect of UCMR2.
Need the final list of EPA approved
Labs? Need a fact sheet about List 1 or
List 2 monitoring? Answers to the above
questions, and tons of other information,
can be found at the UCMR2 homepage:
http://www.epa.gov/safewater/ucmr/
ucmr2
Friendly support staff: Have questions
that no other tool can answer? Get the
fix you need using the contact information on page 7.

UCMR2 Tools Crossword Challenge!
Test your knowledge of UCMR2 by completing the
UCMR2 crossword challenge. Read about the UCMR2
tools in this issue of The Update and see if you can fill in
the blanks!

Across
1 Link on the UCMR2 Web site to
find the UCMR Reference Guide
4 Labs can view and edit their ____
list in SDWARS
6 List 1 monitoring
9 Acronym for the Central Data Exchange, where SDWARS is accessed
10 Maximum number of contaminants UCMR can monitor every five
years

Down
2 Largest population served by a
small public water system
3 List 2 monitoring
5 Acronym for the Safe Drinking
Water Accession and Review System
7 Small PWS reports are sent to
the PWS and ____.
8 E-mail notifications ____ link
allows States and Regions to keep
track of notices sent to PWSs
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Tools for PWSs
Cutting out the details for PWSs
PWSs are off and running (without scissors)!
They are doing a great job with their sampling
schedules. As a reminder, surface water sites
and sites using ground water under the direct
influence of surface water sample quarterly, 3
months apart, within a 12-month period.
Ground water sites sample twice, 5-7 months
apart, within a 12-month period.

PWSs must contact EPA if their
sample schedule or inventory
needs changed. A great place to
look for further sampling questions is the UCMR Reference
Guide, found on the Web by following the Water
Systems link on the UCMR2 homepage. Fact
sheets for List 1 (Assessment Monitoring) and List
Have questions about your sample schedule or
2 (Screening Survey) contaminants can also be
sample locations (sometimes called invenfound on the Web page.
tory)? Large systems (serving a total population over 10,000) can check their schedule and
inventory in SDWARS (see page 4), and small UCMR can monitor up to 30 contaminants every 5
years, as defined in the Safe Drinking Water Act
systems can check their monitoring review
(SDWA). You can read more about SDWA at
sheet (MRS).
http://www.epa.gov/safewater/sdwa

PWSs searching for Laboratories
Are you a small system
that needs Spanish
sampling instructions?
Contact the UCMR
Message Center
(page 7).

Still searching for an EPA-approved Laboratory to process your UCMR2
samples? The complete list of EPA-approved Labs is on the UCMR2
Web page - click on the Laboratories link and open the document in the
upper right of the page titled “List of Approved Laboratories.”
Remember, UCMR2 samples MUST be analyzed by EPAapproved Laboratories, and this is the all-inclusive list! If you
have not found a Lab, start shopping now because negotiating a Laboratory contract may take some time.

Gearing up for small PWS reports
As small system sampling continues, you
may wonder what happens when the sample leaves your hands and continues on its
way to the Lab. Who gets the Laboratory
results?
Answer: you do! Reports for each small
PWS are generated and mailed to the official contact for the PWS as well as the
contact for the state in which the PWS resides.

But when do you get your report? Reports are generated as data are submitted by Labs and reviewed by
EPA. The gears of UCMR2 are turning and, generally
within 3-6 months of sampling, you will
receive the results of all your hard work
and that of the Labs. Samplers are doing
a great job of collecting water samples
and sending them to their Labs - keep up
the good work!
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Tools for PWSs (Continued)
Toolbox revealed: SDWARS for large PWSs
SDWARS toolbar
options for PWSs:

Confused by SDWARS? Not sure what this tool has to offer? No worries!
Utilizing this important tool can be done by following these simple steps.

⇒ Contacts

Before sampling begins: Confirm contacts, inventory and schedule
information in SDWARS

⇒ Inventory Maintenance

⇒ Nominate User

Important: You must make schedule changes before results are posted on
SDWARS. Request inventory and schedule changes from EPA before samples are collected and data are posted. In the current version of SDWARS,
once data are posted it is impossible to edit inventory or schedules for that
location.

⇒ SDWARS2 Help

•

Go to http://cdx.epa.gov. This is EPA’s Central Data Exchange (CDX), the
primary hub for submission of environmental data. You can access your
SDWARS account by logging into CDX and choosing the UCMR2:
SDWARS link under “Available Account Profiles.”

•

Contacts. Your PWS must list at least one official and one technical contact. If you need to add a contact, choose “Add a Contact” to fill in the contact’s information. Additional contacts are labeled as “Other.” You can edit
a contact or change whether or not to receive e-mail reminders for sample
months by clicking on “Edit” next to any contact.

⇒ Schedule Maintenance
⇒ Review Data
⇒ Compliance Report

“SDWARS2 Help” lists frequently asked questions and
answers about monitoring for
UCMR2 and SDWARS

Don’t have a user name and
password? Use the Customer •
Retrieval Key (CRK) found on
the CRK letter sent to you by
EPA. If you need a CRK,
•
please call the UCMR Message
Center at 1-800-949-1581.

Inventory Maintenance. You can see your sample points and download
or print them, if desired. The downloaded file is a text file (.txt extension)
that most software packages can convert.
Schedule Maintenance. View your sample schedule and add comments about sample events and points. Add comments by clicking the
date under “SE1” - this is where sampling irregularities are tracked by
EPA. Hit “Save” when you are done!

During sampling: Review and approve data uploaded by your Lab
•

Review Data. You can search for data submitted by your Lab for approval. Results are limited to 250 records. If your search returns more than 250 records you must refine your criteria for result viewing. If you
are monitoring for List 2 contaminants, this is also the stage where you MUST enter a disinfectant residual
type. After your review, click on “Save.” When searching, use the percent sign (%) as a wildcard (for example, to search for any sample ID ending with “001”, use the search term “%001”).

•

Compliance Report. View your data for completeness.

•

Nominate User. Give others at your PWS the opportunity to establish a PWS SDWARS account. You will
instantly receive a CRK to give to the nominee so that they can register for access.

Important: Your Laboratory must post your UCMR2 data to SDWARS within 120 days from the sample collection date. Unless you un-check the “receive e-mail notification” checkbox during registration, you will receive an e-mail notifying you when your Laboratory posts data to SDWARS. If you do not act on data
posted by your Lab within 60 days, it will be automatically approved.
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Tools for Labs
Labs measure their success
Labs are off to a great start analyzing samples
and posting results. In SDWARS, remember that
after data are approved they cannot be changed
without contacting the UCMR Sampling Coordinator (see page 7 for the email address). If sample
recollection is required due to improper sampling
or shipment (e.g. temperature limit exceeded) or
Lab error (e.g. quality control failure), the Laboratory must contact the PWS immediately and the

PWS must recollect the sample
within 30 days.
As you receive and analyze samples
for PWSs, questions about UCMR2
may arise. The UCMR2 Web site (see page 7 for the
Web address) and SDWARS are valuable tools for answering those questions. And remember all the contacts (listed on page 7) that can serve as further resources.

SDWARS for Labs
•

Go to http://cdx.epa.gov. This is EPA’s Central Data Exchange (CDX),
the primary hub for submission of environmental data. You can access
your SDWARS account by logging into CDX and choosing the UCMR2:
SDWARS link under “Available Account Profiles.”

•

Client List. This is a list, created by you, of all PWS clients for which you
will be submitting data to SDWARS. You can add and delete PWSs to or
from your client list here. A PWS must be on your client list before you
can enter and review data in SDWARS.

•

Enter Data. Add, edit, or delete sample information and analytical results
here. Enter results after choosing a method. Data reporting can be made
easier by choosing “All<MRL,” if appropriate, when entering data and
“Approve all” when approving data.

SDWARS toolbar
options for Labs:
⇒ Client List
⇒ Enter Data
⇒ Inventory/Schedule
⇒ Review Data
⇒ Upload File
⇒ Nominate User

•

Inventory/Schedule. Search by PWS or State for your client PWSs’
inventory and schedule.

•

Review Data. Review and lab-approve analytical results. Your PWS
clients can review their data only after you have lab-approved the results in SDWARS.

•

Upload File (optional electronic upload). Browse for your flat/tab
delimited or XML file. Implementation guides for preparing your electronic upload file are available for download from your SDWARS Lab
home page. When entering data, a range check violation warning box
will appear if results are out of an expected range or if the data are
deemed invalid for some reason. If the data are okay, override the
warning by closing this box and save the data.

•

Nominate User. You can give others at your Lab the opportunity to
establish a Laboratory SDWARS account. You will instantly receive a
CRK for the nominee so they can register to gain access.

EPA-approved Laboratories post
analytical results for review by
public water systems (PWSs),
PWSs meet their reporting
requirements, and States and
EPA review PWS’s monitoring
results, through SDWARS.
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Tools for States and Regions

States and Regions digging up the facts
States and Regions are busy working with PWSs and reviewing data
in SDWARS. EPA appreciates all
of the hard work Regions and partnering States contribute to the
UCMR2 monitoring effort. Take advantage of your UCMR2 resources to keep up the
good work. Tools for States and Regions include all

the information on the UCMR2 Web site, as
well as SDWARS for reviewing large PWS
data and monitoring overall compliance progress of PWSs in a State. SDWARS tracks
large PWS inventories, compliance, sampling schedules, and contacts for State and
Region officials. Stay out of
the dark with SDWARS!

SDWARS for States and Regions
SDWARS toolbar
options for States and
Regions:

•

Go to http://cdx.epa.gov. This is EPA’s Central Data Exchange
(CDX), the primary hub for submission of environmental data. You
can access your SDWARS account by logging into CDX and
choosing the UCMR2: SDWARS link under “Available Account
Profiles.”

•

Review Data. You can search for data in your State or Region that
have been PWS approved. You can refine your search to many different criteria, including all results greater than the minimum reporting level (MRL), and can sort by analyte and/or by status.

•

Select PWS. View information on each PWS in a State using five
options:

⇒ Review Data
⇒ Select PWS
-All Inventory
-Inventory w/ Schedule
-Contacts
-Compliance Report
-Email Notifications Audit

1. All inventory lists all of the sample sites for a particular PWS.
2. Inventory w/ Schedule gives dates for sample events at each sample point.
3. Contacts lists the contacts for a PWS.
4. Compliance Report lists results for each sample event. If there are no results
posted for a past scheduled sample date, the PWS may be out of compliance.
5. E-mail Notifications Audit lists sampling notifications and the contact to
whom they were sent. This information can assist the investigation of noncompliant PWSs.

You can
print or
download
these
reports.

Large system sampling reminders and small
system reports
SDWARS is the way to keep track of large PWSs (serving over 10,000 customers). If large PWSs in
your State or Region ask about receiving sampling reminders, don’t worry about sending out hundreds of e-mails! Through SDWARS, PWSs receive an automated e-mail reminder 15 days before
sampling is scheduled (see page 4). Also, states will receive a copy of small system reports from
EPA.
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Now we can all get to work!
Whew, that’s quite a tool box! UCMR2 monitoring can be much easier when you have your toolbox to lean on. Whether you need to
check a sample schedule, review sample locations, list monitoring
results for a State or Region, or add or edit a contact, SDWARS is
the tool for you. General questions about sampling, EPA-approved
Laboratories, Screening Survey or Assessment Monitoring contaminants, and procedures, can all be found at the UCMR2 Web site.
Keep up the good work!

The UCMR2 Web site:
http://www.epa.gov/safewater/ucmr/ucmr2

Questions about your tools?

Is there more information you
would like in The UCMR
Update? Think we have (or
haven’t) hit the nail on the
head with this issue? Let us
know! Send feedback to:
UCMR_Sampling_Coordinator
@epa.gov

Safe Drinking Water Hotline: General UCMR questions: 1(800)426-4791

Thank you!

CDX/SDWARS Help Desk: SDWARS/UCMR registration and electronic reporting system questions: 1(888)890-1995
UCMR Message Center: UCMR implementation questions: 1(800)949-1581
UCMR Sampling Coordinator Correspondences:
Mail: UCMR Sampling Coordinator
U.S. Environmental Protection Agency
Technical Support Center (MS-140)
26. W. Martin Luther King Drive
Cincinnati, OH 45268
Fax: (513)569-7191
E-mail: UCMR_Sampling_Coordinator@epa.gov

Laboratories and PWSs: When
contacting EPA about UCMR
issues, please use your U.S. EPA
Lab ID or Federal PWSID,
respectively.

UCMR 2 Tools Crossword Challenge Answers:
Across: 1. water systems, 4. client, 6. assessment, 9. CDX, 10. thirty
Down: 2. ten thousand, 3. screening survey, 5. SDWARS, 7. state,
8. audit

Please contact the UCMR Sampling Coordinator if you are not the correct person to receive this newsletter,
your address needs to be corrected, or you do not want to receive this newsletter. Please include your name,
PWSID (or Lab ID), the name of the PWS (or Laboratory), and, if applicable, the way you want to receive
the newsletter: e-mail or mail. Thank you.

